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Лабораторная работа 1 
Создание текстовых эффектов 

 
Цель работы: освоить принципы работы с текстом в AdobePhotoshop с 

применением различных эффектов. 
 

Основные положения 
 
TypeTool (Текст) – это инструмент AdobePhotoshop, представляющий 

собой набор векторных контуров и математических фигур для определения 
символов шрифта. Он расположен на Панели инструментов в Photoshop в виде 
буквы Т. Инструмент множественный. 

Горячая клавиша «T» – текст. Если нажать кнопку Т и удерживать ее 
нажатой, откроется четыре варианта этого инструмента: 

− HorizontalTypeTool (Горизонтальный текст) – инструмент для 
создания горизонтального стандартного текста (слева направо и сверху вниз), 
обычный текст по умолчанию. Пишет тем цветом, который выбран в качестве 
ForegroundColor (Цвет переднего плана). 

− VerticalTypeTool (Вертикальный текст) – инструмент для 
создания вертикального текста (сверху вниз и справа налево), полезно для 
создания надписей на восточных языках, таких как японский или китайский. 

− HorizontalTypeMaskTool (Горизонтальный текст-маска) – 
создает быструю маску, используя выделение в форме введенного текста. 

− VerticalTypeMaskTool (Вертикальный текст-маска) – создает 
быструю маску, вертикальное выделение. 

Есть два способа создать текстовый слой: 
1. PointType: эта опция позволит создать текстовый слой в одну 

линию. Щелкните мышкой там, где хотите написать текст. На месте щелчка 
появится мигающий вертикальный курсор. После того, как введёте текст, 
нажмите на галочку на панели параметров «применить текущую правку» или 
кликнув один раз на слое с текстом, или нажмите сочетание клавиш Ctrl+Enter, 
можно также нажать Enter на цифровой клавиатуре. Если Вы просто нажмёте 
Enter, то курсор перейдёт на следующую строку, предлагая продолжать ввод 
текста. 

2. ParagraphType: позволяет создать текстовый слой в 
ограничительной рамке. Это очень полезно для печати и веб-дизайна. 
Используя инструмент Type, выделите для текста место. Начните с верхнего 
левого угла и тяните курсор по диагонали до нужного размера, введите текст и 
нажмите Ctrl+Enter. Текст можно не только вводить (с клавиатуры), но и 
вставлять из других редакторов. 
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Инструмент TypeTool (Текст) всегда создает новый слой для нового 
текста. 

Можно изменять размеры и перемещать каждый текстовый слой как 
любой другой при помощи инструмента MoveTool (Перемещение). При 
помощи команды FreeTransform (Свободное трансформирование) можно 
изменять размеры текста, поворачивать, деформировать и искажать так же, как 
с другими объектами. Можно применять разнообразные эффекты слоя для 
созданного текста. 

Еще вы можете изменять размер текста при помощи рамки выделения 
ParagraphType: квадратики по углам прямоугольника и в середине отрезков 
называются узлами, перетаскивая их, можно выполнить любое преобразование 
формы выделенного текста. Чтобы сохранить пропорции, удерживайте 
клавишу Shift. 

Для изменения размера созданного ранее текста выберите инструмент 
TypeTool (Текст) и щёлкните курсором мышки по текстовому слою поверх 
надписи. 

Щелкните и тяните узел, чтобы изменить размеры рамки редактирования. 
Чтобы повернуть текст, выберите инструмент TypeTool (Текст) и 

щёлкните по текстовому слою поверх надписи. 
Затем передвиньте курсор так, чтобы он был вне рамки редактирования. 

Курсор должен измениться в изогнутую стрелку, и поворачивайте созданный 
текст. Удерживая Ctrl, тяните узел и получите угловое изменение. 

 
Задание 1 

Создайте трехмерный текстовый объект по заданию преподавателя. 
 

Порядок выполнения 
1. Создайте изображение размером 1000 на 1000 пикселей. Заполните 

первый слой темно-серым цветом и назовите его Back (для переименования 
слоя кликните правой кнопкой мышки в меню слоев и выберите пункт меню 
Layerproperties, и измените имя слоя на Back). Мы заполняем фоновый слой 
темно-серым цветом для того, чтобы были лучше видны трехмерные буквы. 

2. Создайте новый уровень и назовите его GroundLetters. Он должен 
находиться выше уровня Back. 

3. Выберите TypeMaskTool(T) и щелкните им где-нибудь в центре 
изображения. Выберите шрифт (например, Impact). Напечатайте слово и 
поставьте размер шрифта приблизительно 400-600 pt. Нажмите [OK]. 
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Рисунок 1 – TypeMaskTool 

 
4. На слое GroundLetters залейте выделенную текстом область белым 

цветом. Теперь отмените выделение (Ctrl+D). У вас должна получиться 
надпись, как на рисунке 2. 

 

 
Рисунок 2 – Исходный текст 

 
5. В главном меню выберите: Edit/Transform/Skew. Переместите правый 

верхний и нижний углы так, как показано на рисунке 3. 
 

 
Рисунок 3 – Исходный текст 

 
6. Сделайте копию слоя GroundLetters, назовите этот слой Guide. 
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Рисунок 4 – Создание дубликата слоя 
 

7. Измените прозрачность (Opacity) слоя GroundLetters до 50 %. Теперь 
выберите слой Guide и сдвиньте его на 100-200 пикселей влево. Выставите у 
него прозрачность до 20 %. В итоге ваше изображение должно выглядеть 
подобно приведенному на рисунке 5. 

 
 

Рисунок 5 – 2 слоя 
 

8. Выберите слой Guide. Выберите в меню: Edit/Transform/Scale. 
Уменьшите немного высоту символов слоя Guide примерно так, как показано 
на рисунке 6. В дальнейшем это уменьшение создаст иллюзию глубины. 
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Рисунок 6 – Уменьшение слоя Guide 
 

Теперь сделайте копию слоя Guide. Переименуйте его в Gside. Этот слой 
должен находиться выше слоя Guide. Создайте новый слой и назовите его 
Gside2. Расположение ваших слоев в порядке сверху вниз должно быть 
следующим: GroundLetters-Gside2-Gside-Guide-Back. Back должен быть залит 
серым цветом, Guide должен быть более укороченной версией слоя 
GroundLetters, Gside должен быть копией слоя Guide, Gside2 сейчас должен 
быть пуст. Если ваши слои так не выглядят, значит вами где-то допущена 
ошибка. 

10. Выберите инструмент PolygonalLasso  
11. Выберите слой Gside2. Используйте PolygonalLasso для того, чтобы 

соединить соответствующие стороны первой буквы на слое GroundLetters и 
слое Guide. Добавьте выделение для других частей первой буквы, а также для 
остальных букв. Теперь заполните выделение белым цветом, удостоверившись, 
что вы делаете это на слое Gside2. 

 

 
 

Рисунок 7 – Уменьшение слоя Guide 
 

12. Измените прозрачность слоя Gside до 100 %. Теперь объедините слои 
Gside2 и Gside. Для того чтобы это сделать выберите слой Gside, нажмите Shift 
и щелкните по слою Gside2, затем в контекстном меню выберите пункт 
LinkLayers. В результате появится иконка цепи, что означает объединение 
слоев. Теперь зайдите в меню и выберите Layer/MergeLinked. Теперь должен 
получиться один слой под именем Gside. 

13. Выберите слой Gside и, удерживая нажатой клавишу CTRL, выберите 
слой GroundLetters. Появится выделенный контур этого слоя. Удостоверьтесь, 
что вы все еще на слое Gside и нажмите DEL. Это позволит стереть все 
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сегменты слоя Gside, которые были внутри выделения слоя GroundLetters. 
Теперь выберите Erasertool  и сотрите все оставшиеся небольшие 
фрагменты, которые не входят в буквы. 

14. Создайте затенение букв с помощью инструмента GradientTool. 
Удерживая CTRL, выберите слой Gside. Создайте два новых слоя выше 
слоя Gside, назовите их Topshade и Bottomshade. Используйте градиент один 
раз на каждом слое для того, чтобы затенить боковину первой буквы (рисунок 
8). Объедините оба новых слоя со слоем Gside. 

 

 
 

Рисунок 8 – Затeнение буквы 
 

15. Затем удалите слой Guide и измените слой Back. Если вы знаете как 
работает источник света, то вы можете достичь градиентом иллюзию 
трехмерного затенения. Ваш окончательный рисунок должен выглядеть 
подобно приведенному на рисунке 9. 

 
 

Рисунок 9 – Окончательный текст 
 

Задание 2 
Создайте изображение с эффектом «пластиковый текст» по заданию 

преподавателя 
 

Порядок выполнения 
1. Создайте новое изображение размером 300х200 пикселей. В качестве 

цвета переднего плана (ForegroundColor) выберете RGB(26, 104, 175). 
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2. Активируйте инструмент Текст(T) и введите его. Измените размер 
текста таким образом, чтобы он занял 90 % изображения по вертикали. Можно 
выбрать шрифт TimesNewRoman (жирный курсив). 

 

 
 

Рисунок 10 – Исходный текст 
 

3. Удерживая Ctrl, щелкнем по слою life в палитре Слои (Layers), тем 
самым выделив его. Создадим новый слой. Переименуем новый слой в 
InnerGlow. Уменьшим выделение на 3 пикселя: Select–Modify–Contract. Введем 
значение 3 пикселей. 

 

 
 

Рисунок 11 – Уменьшение выделения 
 

4. Определим в качестве цвета переднего плана Белый (White) и зальем 
выделение с помощью комбинации Alt+Backspace. Теперь снимем выделение 
Ctrl+D и применим к активному слою фильтр GaussianBlurс параметром 8 
пикселей: Filter–Blur–GaussianBlur. Вводим значение 8 пикселей. Затем сделаем 
то же самое, но с параметром 4 пикселей; и третий раз, но уже со значением 2 
пикселя. Установим прозрачность слоя на уровне 52 % и Режим смешивания 
(BlendingMode) на панели Слои (Layers) изменим на ColorDodge. 
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Рисунок 12 – Текст после применения фильтра 
 

5. Удерживая Ctrl, в панели Слои (Layers) щелкните мышью на слое life, 
чтобы выделить его. В панели Каналы (Channels) сохраним выделение в канале 
посредством нажатия на пиктограмму кнопки «Сохранить выделение как 
канал» (SaveSelectionaschannel), дав имя каналу Select. Сделаем новый канал 
активным, нажав на его представление в панели Каналы (Channels). Примените 
к нему фильтр GaussianBlur. В первый раз со значением 8 пикселей, затем, по 
нисходящей, 4 пикселя и, наконец, 2 пикселя. Инвертируем выделение, 
выполнив команду Ctrl+Shift+I, очистим выделение с помощью Del и в конце 
концов снимем выделение Ctrl+D. 

 

 
 

Рисунок 13 – Выделенный канал 
 

6. Выделите слой life (Ctrl + щелчок по слою в списке). Создайте новый 
слой и переместите его над слоем InnerGlow. 

Выделите новый слой, залейте его черным цветом и переименуйте в 
Highlights. Установите Режим смешивания (Blendingmode) в позицию Screen. 

7. При активном слое Highlights выполните команду Filter–Render–
LightingEffects. В открывшемся диалоговом окне установите такие значения: 

− глянец (Gloss): 79; 
− материал (Material): -37; 
− экспозиция (Exposure): 56; 
− среда (Ambience): -100. 
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Измените Текстурный канал (Texturechannel) на Select. Значение Высоты 
(Height) этого канала определим в размере 100. Следующим шагом будет 
создание Направленного света (DirectionalLight) с Интенсивностью (Intensity) 
равной 32, таким образом, чтобы освещение покрывало большую часть текста, 
но самыми яркими участками объекта являлись его края. По окончанию 
создания Световых эффектов (LightingEffects) применим к активному слою 
фильтр GaussianBlur со значением 1,5 пикселя, чтобы избавиться от 
неровностей краев. 

8. Выполните команду Image–Adjustments–Curves. В диалоговом окне 
«Кривые» (Curves) всегда сначала наблюдается прямая линия. Кликните на 
любом месте прямой, чтобы создать новую точку, и перетащите затем 
созданную точку в произвольном направлении (рисунок 14). 
Поэкспериментируйте самостоятельно с кривыми для достижения 
«пластичного» эффекта. 

 
 

Рисунок 14 – Окно «Кривые» (Curves) 
 

 
 

Рисунок 15 – «Пластичный» текст 
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Лабораторная работа 2 
Создание коллажей 

 
Цель работы: освоить принципы создания коллажей в AdobePhotoshop, 

изучить различные режимы наложения. 
 

Основные положения 
 

Для создания коллажей необходимо применять различные режимы 
выделения фрагментов изображения. 

Самый простой способ создать выделение в AdobePhotoshop – это 
воспользоваться режимом Быстрой маски – QuickMask. 

Режим QuickMask/Быстрой маски 
Для перехода из обычного режима рисования в 

режим QuickMask необходимо нажать на кнопку  внизу палитры 
инструментов или воспользоваться «горячей» клавишей Q. 

В режиме QuickMask (Быстрой маски) необходимо инструментом Pencil 
(Карандаш) или Brush (Кисть) с жестким краем (Hardness 100 %) закрасить 
черным цветом (который в режиме QuickMask/Быстрой маски будет 
представлен полупрозрачным красным) те элементы, которые необходимо 
удалить с изображения. 

После этого следует вернуться в обычный режим рисования, нажав на 
кнопку  внизу палитры инструментов, и инвертировать выделение, выбрав из 
меню Select (Выделить) команду Inverse (Инвертировать). Инвертировать 
выделение необходимо, так как при работе в режиме QuickMask в выделение 
попадает та часть изображения, которая не была закрашена. Можно, конечно, 
изначально в режиме быстрой маски закрашивать то, что на изображение не 
должно попасть в выделение, а ненужные объекты и дефекты оставлять не 
закрашенными, но, скорее всего, этот процесс будет более трудоемким. 

Кроме того, в AdobePhotoshop для выделения части изображения можно 
использовать любой из инструментов выделения: Rectangularmarquee 
(Прямоугольное выделение), Ellipticalmarquee (Эллиптическое выделение), 
Lasso (Лассо), PolygonalLasso (Полигональное лассо), MagneticLasso 
(Магнитное лассо), MagicWand (Волшебная палочка). 

Инструменты Rectangularmarquee (Прямоугольное выделение) и 
Ellipticalmarquee (Эллиптическое выделение) на панели инструментов скрыты 
за одной пиктограммой. На панели инструментов отображается пиктограмма 
последнего выбранного инструмента. Для того чтобы открыть всплывающее 
меню, необходимо нажать правой кнопкой мыши на стрелке справа, внизу от 
данной пиктограммы. 

Для того чтобы выделить квадратную область изображения, необходимо 
при выделении удерживать нажатой клавишу SHIFT. Следует учесть, что если 
уже имеется какая-то выбранная область, то при использовании 
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клавиши SHIFT произойдет ее наращивание. Поэтому следует 
нажимать SHIFT только тогда, когда уже начнется выделение области. 

Для того чтобы выделить окружность необходимо при выделении 
удерживать нажатой клавишу SHIFT.  

Если при выделении прямоугольной или эллиптической области на 
изображении удержать нажатой клавишу Alt, то контур будет образовываться 
от центра к границам, а не от одного угла к другому. 

Инструменты Lasso (Лассо), PolygonalLasso (Полигональное лассо), 
MagneticLasso (Магнитное лассо) на панели инструментов скрыты за одной 
пиктограммой. На панели инструментов отображается пиктограмма последнего 
выбранного инструмента. Для того чтобы открыть всплывающее меню, 
необходимо нажать правой кнопкой мыши на стрелке справа, внизу от данной 
пиктограммы. 

Lasso (Лассо) 
Инструмент предназначен для создания выделений произвольной формы. 
PolygonalLasso (Полигональное лассо) 
Инструмент так же предназначен для создания выделений произвольной 

формы, но при этом контур выделения состоит из прямолинейных сегментов. 
MagneticLasso (Магнитное лассо) 
Инструмент предназначен для выделения областей произвольной формы. 
При использовании инструмента MagneticLasso (Магнитное лассо) не 

требуется очень точно следовать контуру выделяемого объекта. Если объект 
имеет достаточно хороший контраст по отношению к окружающему его фону, 
то линия границы выделяемой области будет сама притягиваться к краю 
объекта. 

MagicWand (Волшебная палочка) 
Инструмент предназначен для выделения области с одинаковыми или 

подобными по цвету пикселями. Параметры допуска устанавливаются с 
помощью параметра Tolerance (Допуск) на панели опций данного инструмента. 
Чем больше величина этого параметра, тем больше цветов попадает в 
выделенную область. Значение допуска меняется от 0 до 255. При допуске, 
равном 0, выделяется область одного цвета, при допуске, равном 255, –  
выделяются все цвета, то есть все изображение. 

Гибкость использования перечисленных инструментов обеспечивается 
тем, что выделяемые ими области можно складывать, вычитать друг из друга, 
получать пересечение двух нарисованных рамок. 

Для того чтобы добавить новое выделение к старому, необходимо перед 
использованием инструмента нажать на клавиатуре клавишу SHIFT и, 
удерживая ее, осуществить выделение. 

Для того чтобы вычесть новое выделение из старого, необходимо перед 
использованием инструмента нажать клавишу Alt. 

Совместное использование клавиш SHIFT и Alt приводит к тому, что 
выделенной остается область совмещения (наложения) старого и нового 
выделения (Shift). 
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Задание 1 

Создайте изображение-коллаж. Исходные файлы для выполнения работы 
размещены в папке, указанной преподавателем.  

Порядок выполнения 
1. Откройте основную фотографию (1.jpg) и удалите нижнюю часть ее 

так, как показано на рисунке 16. Увеличьте размер холста в 2 раза по вертикали 
(Image–Canvassize). 

 
 

Рисунок 16 – Исходное изображение 
 

2. Сделайте копию изображения (Ctrl+J) и отразите его по вертикали Edit– 
Transform –Flipvertical. 

 
 

Рисунок 17 – Изображение + отражение 
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3. Создайте новый слой и сделайте выделение нижней части фотографии 

(Ctrl+Click по слою с фотографией, которая находится внизу). Закрасьте это 
выделение цветом #04274d. Установите режим смешивания на Color. 

 

 
 

Рисунок 18 – Режим смешивания Color 
4. Сделайте активным слой с нижней фотографией. Активируйте Burn 

Tool, Range выберите Midtones. Сделайте фотографию более темной и 
насыщенной. 

 
 

Рисунок 19 – Затемнение и увеличение насыщенности 
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5. Откройте первую фотографию с облаками (4.jpg) и поместите её 

наверх. 

 
 

Рисунок 20 – Наложение облаков 
 

6. Смените режим смешивания на Overlay. 

 
 

Рисунок 21 – Режим смешивания Overlay 
 

7. Откройте вторую фотографию с облаками (5.jpg) и поместите её вниз. 

 
 

Рисунок 22 – Наложение облаков 
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8. Меняем режим смешивания на SoftLight. 
 

 
 

Рисунок 23 – Режим смешивания SoftLight 
 

 
 

Рисунок 24 – После изменения режима смешивания 
 

9. Чтобы избавиться от желтых пятен можно использовать Ластик. 
10.Откройте первую фотографию с планетой (2.jpg) и поместите её 

посередине изображения снизу. 

 
 

Рисунок 25 – Наложение изображения нижней планеты 
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11. Откройте вторую фотографию планеты (3.jpg), поместите её 

посередине верхнего изображения, немного трансформируйте, удалите лишнее, 
используя мягкий ластик. Режим смешивания нижней планеты измените на 
LinearDodge. 

 
Рисунок 26 – Наложение изображения верхней планеты 

 
Режим смешивания верхней планеты измените также на LinearDodge. 
13. Создайте новый слой и используйте кисточки звезд белого цвета. 
 

 
 

Рисунок 27 – Окончательное изображение 
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Лабораторная работа 3 
Рисование 

 
Цель: изучить принципы работы с контурами в Adobe Photoshop, освоить 

использование инструмента PenTool и инструментов выделения. 
 

Задание 1 
Нарисовать бокал (рисунок 28) с помощью инструмента PenTool. 

 
 

Рисунок 28 – Изображение бокала 
 

Порядок выполнения 
1. Создайте новый файл изображения с размером холста 250х550. 

Нарисуйте контур содержимого с помощью инструментов PenTool и 
ConvertPointTool. 

 

 

Рисунок 29 – Контур содержимого 
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2. Растрируйте слой. Выделите содержимое слоя, зажимая Ctrl и нажимая 

мышкой на изображение слоя на панели слоев. Задайте цвета: EE5141 и 
8E0F04. Выберите инструмент «Градиент», тип «radial» и залейте выделение 
градиентной заливкой, как на рисунке 30: 

 
 

Рисунок 30 – Применение градиента «radial» 
 

3. Изобразите верхнюю поверхность содержимого бокала. Создайте 
выделение с помощью EllipticalMarqueeTool. Создайте новый слой, залейте 
градиентом с теми же цветами, но выберите тип «линейный» (рисунок 31). 

 

 
 

Рисунок 31 – Применение линейного градиента 
 
4. Нарисуйте стекло. Для наглядности создайте фон (например, серый 

градиент 111111 и 666666). 

 
 

Рисунок 32 – Фон 
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5. Выберите слой с верхней поверхностью содержимого бокала, загрузите 

выделение. При выбранном инструменте «выделение» нажмите клавиши Shift + 
«стрелка вверх» шесть раз. Таким образом, выделение поднимется вверх. 
Чтобы соблюсти законы перспективы, выберите Select–TransformSelection и 
уменьшите его в высоту. Затем выберите Select–Modify–Border–2px. Создайте 
новый слой и залейте выделение белым цветом (рисунок 33). 

 

 
 

Рисунок 33 – Рисование верхнего края бокала 
 
6. Добавьте к полученному слою маску и проведите градиент справа 

налево, как на рисунке 34. 

 
Рисунок 34 – Применение градиента 

 
7. Создайте новый слой с прозрачностью 20 % и с помощью PenTool 

нарисуйте блик (рисунок 35). 
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Рисунок 35 – Рисование блика слева 
 
8. Создайте новый и с помощью инструмента PenTool нарисуйте еще 

один блик (справа) прозрачностью 10 %. Измените также прозрачность слоя с 
ободком (например, 50 %). 

 

  
 

Рисунок 36 – Рисование блика справа 
 

9. Используя PenTool, создайте на новом слое фигуру, как показано на 
рисунке 37. Затем растрируйте слой, создайте выделение, залейте черным и 
расположите позади всех слоев. 
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Рисунок 37 – Рисование ножки 
 

10. Создайте выделение для удаления «лишней» части черной фигуры. 
Удалите ненужную часть. 

 
 

Рисунок 38 – Удаление «лишней» части 
 

11. Дублируйте слой. Копию слоя отразите по горизонтали и совместите с 
оригиналом, чтобы получилась нужная фигура (рисунок 39). 
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Рисунок 39 – Рисование ножки 
 

12. С помощью эллиптического выделения нарисуйте основание ножки и 
тоже залейте черным. Все элементы черной фигуры объедините в один слой. 

 

 
 

Рисунок 40 – Рисование ножки 
 

13. Обрисуйте с помощью PenTool область на ножке так, чтобы по краям 
оставалась темная область (рисунок 41). 
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Рисунок 41 – Высветление ножки 
 

14. Выполните MakeSlection, Select–Feather–2px. Выбрав слой с ножкой, 
нажмите Delete. Далее с помощью прямоугольного выделения и Select–Feather– 
1 или 2 px (в зависимости от толщины ножки), удалите область внутри ножки. 
Затем с помощью PenTool отрисуйте фигуру в нижней части ножки (рисунок 
42). 

 
Рисунок 42 – Высветление ножки 
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15. Создайте выделение, вырежьте область и вставьте ее на новый слой, 
не меняя местоположения. Создайте на этом слое маску, проведите градиент 
сверху вниз. 

 
 

Рисунок 43 – Приложение градиента 
 

16. Сделайте эллиптическое выделение области в основании ножки, 
вырежьте, вставьте на новый слой на то же место и уменьшите прозрачность 
слоя (например, до 65 %). 

 
 

Рисунок 44 – Основание ножки 
 

Далее можно добавить бликов с помощью кисти. Рисунок можно 
помещать на любой фон. Окончательное изображение должно выглядеть 
аналогично представленному на рисунке 28. 

 
Задание 2 

Нарисовать кнопку с «металлическим» ободком (рисунок 50). 
 

Порядок выполнения 
1. Откройте новый документ размером, например, 250×250 и выберите 

EllipticalMarqueeTool. Сначала нужно создать металлический фон для кнопки. 
Зажмите Shift и нарисуйте круг. Назовите слой One, залейте круг темно-серым 
(#333333). Оставьте выделение и создайте новый слой под названием Two над 
ним. Зайдите в Select – Modify – Contract, 2 пикселя, затем в Select–Modify– 
Feather 5 пикселей. 

2. Выберите умеренно серый цвет (#666666), залейте выделенную 
область. Создайте третий слой под названием Three, не снимая выделение. 
Выберите белый в качестве цвета переднего плана и выберите 
LinearGradientTool. Убедитесь, что выбрана опция ForegroundtoTransparent. 
Кликните и протяните от верха к низу выделения (зажав Shift), чтобы залить 
выделенную область градиентом. Затем, чтобы сделать выделение немного 
светлее, продублируйте слой Three, выполнив Layer–DuplicateLayer, затем 
нажмите Ctrl+E, чтобы выполнить слияние слоев. 
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Рисунок 45 – Шаг 1, 2 
 

3. Создайте новый слой над остальными, назвав его Four. Используйте 
EllipticalMarqueeTool, чтобы создать меньший круг (зажав Shift). Залейте круг 
синим (например, #6699dd). 

 
 

Рисунок 46 – Шаг 3 
 

4. Зажав Ctrl, кликните кнопку нового слоя, чтобы создать новый слой 
под Four. Назовите его SubFour и зайдите в Select–Modify–Expand – 2 пикселя. 
Теперь выберите GradientFill. Используйте градиент от черного к белому, 
протянув его по диагонали. Снизьте opacity слоя SubFour до 80 %. 
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Рисунок 47 – Шаг 4 
 

5. Затем вернитесь в слой Four, кликните на нем правой кнопкой и 
примените BlendingOptions–InnerGlow с настройками по умолчанию. Затем 
примените InnerShadow с настройками по умолчанию. Создайте новый слой на 
Four под названием Dodge, поставьте BlendingMode на LinearDodge. Выберите 
BrushTool с кистью 100 пикселей и Hardness 10 %, а Flow 40 %. Зажмите Ctrl и 
кликните на Four, чтобы загрузить его в выделение. Выберите черепаховый 
цвет (например, #2d8e97) и залейте этот слой для получения приятного 
эффекта. Чтобы сделать это, вам, вероятно, понадобится использовать цвета 
светлее, так же, как и для нижней области. Если нужно, снизьте opacity слоя до 
80 %. После того, как добьетесь нужного результата, кликните Ctrl+E, чтобы 
сцепить этот слой с Four.  

 
 

Рисунок 48 – Шаг 5 
 

6. Создайте наверху новый слой под названием Five. Зажмите Ctrl и 
кликните на Four, чтобы загрузить его в качестве выделения. Залейте эту 
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область белым. Кликните Ctrl+D, чтобы снять выделение. Поставьте 
BlendingMode слоя на Overlay. Нажмите Ctrl+T, чтобы вызвать диалоговое окно 
FreeTransform. Зажмите Shift и сожмите выделение из нижнего угла, чтобы он 
выглядел, как на рисунке 49. Зайдите в Filter–Blur–GaussianBlur, поставьте 
радиус 2.8. Снизьте opacity слоя до 40 % или как потребуется. 

 

 
 

Рисунок 49 – Шаг 6 
 

7. Создайте новый слой наверху под названием Six. Зажмите Ctrl и 
кликните Four, чтобы создать выделение. Залейте его светло-голубым 
(например, #80f2e1). Нажмите Ctrl+D. Нажмите Ctrl+T, чтобы выбрать 
FreeTransform и сжать фигуру, чтобы она выглядела, как на рисунке 50. Зайдите 
в Filter–Blur–BoxedBlur, выберите радиус 5 пикселей. Поставьте BlendingMode 
слоя на SoftLight и opacity на 75 %. 

 
Рисунок 50 – Шаг 7 

 
8. В завершение на кнопку можно добавить логотип. 
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Лабораторная работа 4 
Обработка, ретушь фотоизображений в программе AdobePhotoshop 

 
Цель: освоить принципы использования инструментов ретуши и 

редактирования цвета и контраста изображения. 
 
Для ретуширования подавляющего большинства старых и сильно 

поврежденных снимков используется определенная техника. Прежде чем 
начинать ретушь, необходимо провести анализ снимка и выяснить, какие 
проблемы придется решить в ходе работы. 

Наиболее часто встречающиеся проблемы: 
− недостаточная контрастность фотографии; 
− оторванные уголки, разрывы фотографии; 
− неровные, поврежденные края фотографии; 
− пятна различных размеров на фотографии; 
− пожелтевшая бумага и, как следствие, коричневые оттенки всей 

фотографии; 
− крупные царапины по всей площади изображения; 
− затемнена определенная часть фотографии. 
1. Для того чтобы увеличить (уменьшить) яркость и контрастность 

изображения, необходимо обратиться к строке меню Image (Изображение), 
созданное для работы непосредственно с изображением: Image > Adjustments > 
Brightness/Contrast (Изображение > Настройки/Коррекция > Яркость/Контраст) 
и подобрать необходимые настройки.  

2. Дорисовать оторванные уголки и разрывы фотографии можно с 
помощью инструмента Close Stamp (Штамп), используя подходящие места на 
фотографии в качестве источника (щелкнув левой кнопкой мыши при нажатой 
клавише Alt) и рисуя затем как обычной кистью. Используйте несколько 
кистей, от большой и мягкой до маленькой и жесткой. 

3. Для подравнивания краев фотографии используется инструмент Crop 
(Рамка). Обрезается снимок так, чтобы внутри ограничивающей рамки было бы 
только его содержимое и при этом не пострадала значимая информация. 

4. Исправить различные пятна на фотографии также можно с помощью 
инструмента Close Stamp (Штамп), используя более жесткие кисти и кисти 
максимальной мягкости. 

5. Исправить желтизну фотографии превратив ее в черно-белую можно 
следующим образом: Image>Adjustments>Desaturate (Изображение> 
Настройки/Коррекция > Убрать насыщенность/цветовой тон). 

6. Устранение крупных царапин по всей площади изображения. 
Необходимо создать дубликат слоя с названием Copy (Копия). Убрать 

царапины в нем можно применив фильтр Dust&Scratches (пыль и царапины): 
Filter>Noise>Dust&Scratches (Фильтр>Шум>Пыль и царапины) с настройками: 
Radius – 3, Threshold – 10 и выполнить описанные ниже действия. 
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Отключить просмотр слоя Copy (Копия), щелкнув на палитре Layers 
(Слои) на пиктограмме в виде глаза. Перейти на основной слой и запустить 
инструмент Lasso (Лассо). В режиме Add to selection (Прибавить к области) 
обвести все области с царапинами (каждую царапину отдельно). 

Затем необходимо инвертировать выделение (Shift+Ctrl+I) и, вернувшись 
на слой Копия, нажать клавишу Delete. Склеить слои (Ctrl+E).  

Необходимо снова дублировать рабочий слой. Применить к дубликату 
фильтр High Pass (Смягчение):  Filter>Other>HighPass (Фильтры>Другие> 
Смягчение/Цветовой контраст) с настройками: Radius – 50. 

На палитре Layers (Слои) измените настройки слоя дубликата следующим 
образом: 

BlendingMode (Режим наложения) – на Overlay (Перекрытие); 
− Opacity (Непрозрачность) – на 30%. 
− Склеить слои (Ctrl+E). 
7. Осветлить часть фотографии можно с помощью инструмента Dodge 

(Осветлитель) крупной мягкой кистью. 
 

Задание 
Выполнить ретушь фотографии по заданию преподавателя. 
 

Лабораторная работа 5 
Создание анимированных изображений в AdobePhotoshop 

 
Цель: освоить принципы создания анимированных изображений в 

AdobePhotoshop. 
 

Задание 1 
Создать анимированное изображение сердца. 
 
1. Создайте новый документ размером 300x300 px. Используя PenTool, 

нарисуйте сердце, не установив ShapeLayers и цвет #FD7FA3. Используя 
Movetool, поместите сердце посередине документа.  

 
Рисунок 51 – Шаг 1 

 
2. Выберите Blending Options или Layer>Layer Style>Blending Options. 

Задайте настройки Drop Shadow так, как показано на рисунке 52.  
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Рисунок 52 – Шаг 2 
 

3. Задайте настройки Inner Shadow, Inner Glow, Gradient Overlay, Outer 
Glow, Satin так, как показано на рисунках 53–57. 

 

 
 

Рисунок 53 – Шаг 3 
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Рисунок 54 – Шаг 4 
 

 
 

Рисунок 55 – Шаг 5 
 
 

 
 

Рисунок 56 – Шаг 6 
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 Рисунок 57 – Шаг 7 
 
4. В результате должно получиться изображение, как на рисунке 58. 

 
Рисунок 58 – Шаг 8 

 
 5. Дублируйте слой с сердцем 3 раза и выберите FreeTransform Ctrl+T. На 

каждом слое уменьшаем размер сердца на 5 %. То есть первый дублированный 
слой – 95 %, второй – 90 %, третий – 85 % от оригинала. Самый первый слой 
оставляем без изменений. Идем в ImageReady (Ctrl+Shift+M). Если у вас 
закрыта панель анимации, откройте её. Нажмите на значок  в правом 
верхнем углу панели анимации. Выберите MakeFramesfromLayers. Можете 
скопировать 3-й фрейм и поставить его после 4-го, скопируйте 2-й и поставьте 
его после 5-го, 1-ый после 6-го. Поэкспериментируйте с интервалами времени. 

 

 
Рисунок 59 – Шаг 9 
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Задание 2 
Создать анимированное изображение огня. 

 
1. Откройте документ размером 600х200 и залейте его черным цветом. 

Создайте новый слой.  
2. Теперь выберите инструмент MarqueeTool и сделайте прямоугольное 

выделение в нижней части документа на всю его ширину высотой примерно 
100–120 пикселей, залейте выделение белым цветом. Отмените выделение 
(Ctrl+D). 

3. Выберите Filter–Blur–GuassianBlur и примените значение 10 – 15 px.  
4. Продублируйте слой 3 раза и уберите видимость слоев так, как 

показано на рисунке 60, активизировав при этом 1 слой.  

 
Рисунок 60 – Шаг4 

 
5. Выберите инструмент SmudgeTool . Сделайте установки, 

как указано на рисунке 61. 
 

 
Рисунок 61 – Шаг 5 

 
6. Создайте эффект пламени и проделайте это по всей длине нашего 

документа, при этом можно менять размер brush для более реалистичного 
изображения.  

 
Рисунок 62 – Шаг 6 
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Рисунок 63 – Шаг 6 (результат) 

 
7. Сделайте этот слой невидимым и перейдите ко второму слою. 

Повторите проделанное с первым слоем, при этом стараясь соблюдать 
одинаковую высоту пламени. Проделаем то же самое с последующими слоями, 
не забывая делать невидимым предыдущий слой.  

8. Откройте окно анимации. Создайте 4 кадра так же, как в предыдущем 
задании.  

9. Добавьте цвет пламени. Откройте ColorBalance (рисунок 64). 
 

 
Рисунок 64 – Шаг 9 

 
Примените следующие параметры  
Midtones: [ +60 ] [ 0 ] [ -15 ]  
Shadows: [ +100 ] [ 0 ] [ -30 ]  
Highlights: [ +50 ] [ 0 ] [ -30 ]  
10. Установите время для каждого кадра. Сохраните анимацию (File–

SaveforWeb). 
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